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ABSTRACT

The recent pandemic of Covid-19 has diffused and become concerned to the world. Covid-19
has infected more than 100 million of reported cases according to the WHO with more than 2
million deaths. Shortness of breath is found in 18.6% of Covid-19 infected people. The people
suffered from acute difficulty in breathing need a help from ventilator for breathing. The
ventilator plays important role in saving the Covid-19 patients and other patients suffering from
acute breathing difficulty. Ventilator can aid the patient to breathe easily and supporting the
lungs by letting in the sufficient air. It’s hard to find a ventilator while the demand gets
increased in a pandemic like Covid-19.

Our goal is to design and construct a low-cost and straightforward ventilator system, test
the performance and implement the ventilator system.

To achieve our goal, we divided our works in 5 stages. They are study, design, component
collection, assembling and completion of project. Before starting the product designing, we
have studied regarding journals and thesis papers and taken information from it (reference) to
determine the design of the product. we decided to make the Ventilator System using Bag
Valve Mask (BVM), Servo Motor, Relay, Arduino Nano, SMPS, Oxygen Cylinder, LCD
Display, Regulator and switches. Our designed ventilation system worked beautifully and as
we expected. our Ventilator System is still under development. The model can be improved by

making some changes in the program written by Arduino Software IDE and components.
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CHAPTER 1
INTRODUCTION

1.1 INTRODUCTION

Mechanical ventilation is a necessary tool in every modern intensive care unit (ICU). The type
and intensity of ventilation support required by a patient varies over the course of treatment.
Modern mechanical ventilators are versatile and adapt to patient needs. Commercially available
devices control volume, pressure, or gas flow and the breathing cycle timing. They support
patients who cannot breathe, and who can still trigger a mechanical cycle by a spontaneous
inspiratory effortl .Present-day mechanical ventilators are complex machines, consisting of
many specialized components and featuring several ventilation modes.[1-3] The exponential
growth of COVID-19 in 2020 put ICUs all over the world under unprecedented pressure. The
drastic increase in demand of these devices exceeded the capacity of the existing supply chains,
especially in regions where cross-border supply has been disrupted. This created the need for a
simpler, but technically suitable machine that could be mass-produced on a very large scale

and in a short time frame.

The MVM collaboration has responded to this need by developing the Mechanical Ventilator
Milano (MVVM), a reliable, fail-safe, and easy to operate mechanical ventilator, built from a
small number of readily available parts. The design is inspired by the idea proposed by
Manley[4] back in 1961, i.e. the possibility of using the pressure of the gases from the
anesthetic machine as the motive power for a simple apparatus to ventilate the lungs of the
patients in the operating theatre [5] , but using a completely different design, i.e. in particular,
replacing all moving mechanical parts with electro-mechanical components, allowing better
parameter control and improving robustness and reliability in the long-term operation, often
needed by COVID-19 patients.

The MVM was designed in a collaboration between healthcare professionals and experimental
physicists, benefiting from the medical expertise of the former and the latter’s technical
expertise in designing gas handling systems, with industrial partners (Elemaster, Italy and
Vexos, Canada) who provided access to laboratories and production lines for both R&D and
prototype construction. The MVM was certified by the Center for Devices and Radiological
Health, U.S. Food and Drug Administration (FDA) for Emergency Use Authorization in May

1



2020, in response to concerns relating to insufficient supply and availability of FDA-cleared
ventilators for use in healthcare settings to treat patients during the COVID-19 pandemic, and
received Health Canada Medical Device Directorate Authorization for Importation or Sale,
under Interim Order for Use in Relation to COVID-19 in September 2020. A production run

of 6000 units was recently performed in Canada (Vexos and JMP Solutions).

The cost of a single unit turned out to be about 10000 US$, about five times less than
commercially available mechanical ventilators for ICUs. The MVM is a mechanical ventilator
for adult patients assisted with tracheal tubes, designed to control pressure, while the resulting
delivered volume is measured. Pressure control is widely used for COVID-19 patients, who are
susceptible to further lung damage from too high a pressure or volume. The MVM can be
operated in two modes, pressure-controlled ventilation (PCV), and pressure-support ventilation
(PSV). In PCV mode, the ventilator controls the timing of the breathing cycle and regulates the
pressure applied to the patient. PCV mode is used in the acute phase of the disease when
patients are deeply sedated or paralyzed. By delivering the mechanical breath with an
exponentially decelerating flow pattern, PCV allows pressures to balance across the lung units
during a preset time, resulting in significantly reduced pressures and in improved distribution
of ventilation. This lowers the risk of barotrauma attributable to the high pressures often

required to ventilate these patients.[6]

PSV is an assisted ventilatory mode that is patient triggered, pressure-limited, and flow-cycled.
The main use of this mode is for the weaning of the patient from mechanical ventilation,
because it unloads the work of breathing and allows a gradual decrease of ventilator support
until extubation. Invasive mechanical ventilation exposes the patient to risks arising from
infections, pneumothorax, ventilator-associated lung injury, and oxygen toxicity, as well as
from operator error. Therefore, the MVM has a sophisticated integrated alarm system, in
accordance with EN 60601- 1-8:2007, that monitors the various aspects of the breathing cycle
and alerts the operator when any anomaly arises. The hardware and software are designed to
be as straightforward as possible to mitigate the risk of operator error. In addition, the MVM

must be used in association with an oximeter and a manometer.



1.2 MEDICAL CONSIDERATION

According to current studies, approximately 5 % of patients hospitalized with COVID-19
develop severe lung damage.[7,8] This condition reflects the pathophysiology of severe acute
respi- ratory distress syndrome (ARDS). ARDS is a disease characterized by reduced lung
compliance due to the loss of surfactant function, collapsed lung areas, and accumulation of
interstitial/alveolar plasma leakage. Computerized Tomographic (CT) scans demonstrate
uneven distributions of aerated areas, and dense, consolidated regions of the lung; the
remaining alveolar surface for gas exchange is greatly reduced in adult patients, a condition
termed baby lung. It has been suggested that the clinical management of COVID-19 patients
with severe lung damage should follow the established guidelines for ARDS subjects. This
opinion has been confirmed by a recent study comparing COVID-19 subjects to patients
affected by ARDS due to other causes; the physiological differences between ARDS from
COVID-19 and other causes were found to be small. The principal supportive treatment for
ARDS patients is mechanical ventilation with supplemental oxygen, currently deemed most
appropriate, following a discussion that has been ongoing since the syndrome was first
described in 1967. The tidal volume (Vtidal) is a key parameter, with potentially unfavorable
effects if incorrectly set, such as ventilator-induced lung injury. Starting in the 1970s, a Vtidal
of 12-15 mL per kg of predicted body weight (PBW) was recommended by clinicians until, in
2000, the Acute Respiratory Distress Syndrome Network reported that the length of hospital

stay and mortality could be significantly reduced using a lung-protection strategy.

1.3 OBJECTIVE

The objectives of this project are:

a) To study the Ventilator System for Covid-19 Patient.

b) To design and construct of the Ventilator System.

c) To test the performance of the ventilator system for covid-19 patient.

d) To implement the ventilator system.



CHAPTER 2
LIRERATURE REVIEW

2.1 INTRODUCTION

This chapter is arranged on Literature Review. Here's a look at some of last year's literature,
like our project. By reading them, we can overcome the mistakes of the previous project and
make a more effective project.

2.2 ABOUT BVM BOX (BAG VALVE MASK)

A bag valve mask (BVM), sometimes known by the proprietary name Ambu bag or generically
as a manual resuscitator or "self-inflating bag"”, is a hand-held device commonly used to
provide positive pressure ventilation to patients who are not breathing or not breathing
adequately. The device is a required part of resuscitation kits for trained professionals in out-
of-hospital settings (such as ambulance crews) and is also frequently used in hospitals as part
of standard equipment found on a crash cart, in emergency rooms or other critical care settings.
Underscoring the frequency and prominence of BVM use in the United States, the American
Heart Association (AHA) Guidelines for Cardiopulmonary Resuscitation and Emergency
Cardiac Care recommend that "all healthcare providers should be familiar with the use of the
bag-mask device. Manual resuscitators are also used within the hospital for temporary
ventilation of patients dependent on mechanical ventilators when the mechanical ventilator
needs to be examined for possible malfunction or when ventilator-dependent patients are
transported within the hospital. Two principal types of manual resuscitators exist; one version
is self-filling with air, although additional oxygen (O2) can be added but is not necessary for
the device to function. The other principal type of manual resuscitator (flow-inflation) is
heavily used in non-emergency applications in the operating room to ventilate patients during

anesthesia induction and recovery.

Ventilation is the mechanical process whereby air is taken into and out of the lungs. Situations
in which patients might require ventilatory support range from apnea to patients experiencing

depressed respiratory function. If the patient's rate of breathing decreases significantly it can
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lead to hypercarbia, hypoxia, a lowered ph level and a decreased in respiratory minute volume.
This can result in cardiac or respiratory arrest if it isn't corrected. Expired air ventilation has
been the accepted as the technique of choice since the late 1950's. It has been shown to be an
effective practice for both professionals and laypersons including young children over 5 years
of age. Ventilation using the expired air of the rescuer can be applied to mouth or nose of the

adult victim and mouth-to-nose ventilation of the infant.

Mouth-to-Mouth ventilation and Mouth-to-Nose ventilation can provide effective ventilatory
support to a patient. A Major advantage of these methods of ventilation is that no equipment is
required to effectively offer ventilatory support to the patient. However, the disadvantage of
these methods of ventilatory support are that both methods only offer a limited oxygen supply
due to the fact that oxygen expired from the rescuer will only contain 17 percent oxygen.
Mouth-to-mask Ventilation or Pocket Mask Ventilation. A clear plastic, molded facemask
similar to that used in anesthesia maybe used to provide mouth to mask ventilation. A
unidirectional valve diverts the patient's expired air away from the rescuer and traps any
macroscopic particles emerging from the patient. This valve improves the aesthetics arid
reduces risk of cross infection or contamination. The mouth to mask method is a two handed
technique which produces a better seal than Bag-valve Ventilation or Bag-valve-mask (BVM)
is a self-inflating bag can be connected to a facemask, a tracheal tube, a laryngeal mask, or a
combitube. The bag consists of a transparent facemask, one-way valve, oblong self-inflating

silicone or rubber bag, and oxygen reservoir.

It comes available in infant, child and adult sizes. Depending on make or model of BVM they
may or may not have a pop-off release valve. A Pop off release valve allows excess pressure
of air being forced into the mask from the bag to be released under certain centimeter of water
pressure with allows air to escape. Thereby reducing potential volume Higgins and Yared (1993)
and Todres (1993). In most cases the pop off valve should be disabled. Failure to do so could
result in inadequate artificial ventilation. The oxygen inlet and reservoir allow for high
concentration of inspired oxygen (80% to 100%). The BVM device should be used in
conjunction with high-flow oxygen. These devices have a one-way or non-rebreather valve to

maintain.high concentrations of inspired oxygen.



The volume of most adult BVM is approximately 1600 milliliters (mL). Despite what appears
to be large volume for ventilation, the BVM provides less volume than the mouth-to-mask
ventilation, if an airtight seal is not obtained between the mask and the face. An airtight seal is
difficult to maintain unless a second rescuer squeezes the bag to deliver ventilations. Because
of the difficulty of maintaining an airtight seal while squeezing the bag, a single rescuer may
wish to perform mouth to mask ventilation instead of using the BVM alone as delineated by
Circulation. (2000).

When used by one person, a considerable degree of skill is required to maintain a patent airway
and airtight seal with one hand, while squeezing the bag with the other. This is only likely to
be achieved by someone who regularly uses a BVM device. Too much air leakage will result
in hypoventilation, while excessive tidal volumes may result in gastric insufflation and increase
risk of regurgitation. If ventilation has to continue with a BVM, then a two-person technique is
preferable; one person holds the facemask in place using both hands and an assistant squeezes
the bag. In this way a better seal is achieved, the jaw thrust maneuver is more easily maintained
and the patient's lungs can be ventilated more effectively. It has been noted by the 2000
Guidelines on Cardiac Care (2001) that when two rescuers are available the BVM can be very

effective device.

Todres (1993) studied the effectiveness of mask ventilation performed by 112 physicians with
clinical responsibilities at a tertiary referral teaching hospital in Ireland. Participants' physicians
were asked to perform mask ventilation for three minutes on a Resaca Anne using a facemask
and a two-liter self-inflating bag. The tidal volumes generated were quantified using a Laerdal
skill meter computer. The effectiveness of mask ventilation was greater for anesthetists than
for non-anesthetist. Physicians who had attended one or more resuscitation course where no
more effective at mask ventilation than their colleagues who had not undertaken such courses.
It is likely that first responders to in hospital cardiac arrests are commonly unable to perform
adequate mask ventilation. Whereas in research by Elling and Politis (1983) Three hundred and
twenty Emergency Medical Technicians (238 males and 82 females) were tested for the ability
to ventilate a pre-calibrated Laerdal Recording Resusci-Anne using both a BVM and pocket

mask ventilator.



Efficacy of cricoid pressure-in preventing gastric inflation during Bag-Mask Ventilation in
pediatric patients a study done by Salem, Wong, Mani, and Sellick (1974) had ten patients
between the ages of 3 months and 5 years, undergoing elective surgical procedures were studied
under anesthesia and muscle paralysis. In most patients, bag-mask ventilation for a two-minute
period, without cricoid pressure, resulted in appreciable accumulation of gases in the stomach.
The investigation indicates that the simple maneuver of gentle cricoid pressure using the middle
or little finger of the hand holding the mask is effective in reducing gastric distension during
bag-mask ventilation without interfering with its adequacy. Exhaled volumes were greater
during Intermitted Positive Pressure Ventilation with cricoid pressure because gases were

prevented from entering the esophagus and escaping into the stomach. [9]



CHAPTER 3
THEORY & WORKING PRINCIPLE

3.1 WORK FLOW DIAGRAM

Study

Design

Components
Collection

Assembling

Complete
Project

Figure 3.1: Working Flow Diagram

3.2 BLOCK DIAGRAM:

0)4%: 511 Natural
Cylinder Air

Servo Motor

Arduino
Nano Servo Motor

Patient Mask

Figure 3.2: Block Diagram of Ventilator System for Covid-19 Patient.



3.3 CIRCUIT DIAGRAM
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3.4 PROJECT DESIGN
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Figure 3.4: Project Design.
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Figure 3.3: Circuit Diagram of Ventilator System for Covid-19 Patient.
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3.5 WORKING PRINCIPLE

SMPS will be the main power supply of our system. Converting supply voltage from 220 volts
to SMPS 5 volts DC. Here our instruments work at 5 volt DC. Two servo motors are connected
to the output of the micro-controller. These servo motors will put a certain amount of pressure
on the BVM box. This BVM box will be attached to the face mask of COVID-19 patient. This
will reduce the problem of breathing of COVID-19 patients. By doing this, the problem of
breathing administration of COVID-19 patient will be reduced.

3.6 METHODOLOGY

Collecting all components/materials to construct the system. Set up the BVM box according to
the design. Then two servo motors on either side of the BVM box according to the design. Then
connect an electrical valve to the BVM box with a pipe. Attach an oxygen cylinder with the
electrical valve by a pipe. Attach a relay to the electrical valve. Then connect servo motors,
LCD display, controlling regulator, switches, and power supply with the ARDUINO NANO
microcontroller. Then input the program into the microcontroller. Finally, we made this system

& checked it finally that working very well.

3.7 COMPLETE PROJECT PROTOTYPE IMAGE

)

2
f
%

%

MmN

Figure 3.5: Project Prototype Image
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3.8 COMPONENTS LIST:

Arduino Nano
SMPS
Oxygen Cylinder

=

Servo Motor
Relay

BVM Mask
Patient Mask

LCD Display

© © N O U A W N

Regulator and switches
3.9 ARDUINO NANO

Arduino is an open-source electronics prototyping platform based on flexible, easy-to-use
hardware and software. It's intended for artists, designers, hobbyists, and anyone interested in
creating interactive objects or environments. Arduino can sense the environment by receiving
input from a variety of sensors and can affect its surroundings by controlling

Lights, motors, and other actuators.

Figure 3.6 : Arduino Nano

The microcontroller on the board is programmed using the Arduino programming language

(based on Wiring) and the Arduino development environment (based on Processing). Arduino
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projects can be stand-alone or they can communicate with software on running on a computer
(e.g. Flash, Processing, MaxMSP).

Arduino Nano is a surface mount breadboard embedded version with integrated USB. It is a
smallest, complete, and breadboard friendly. It has everything that Diecimila / Duemilanove
has (electrically) with more analog input pins and onboard +5V AREF jumper. Physically, it is
missing power jack. The Nano is automatically sense and switch to the higher potential source

of power.

Vcc

~10 kQ
Resistor
Switch(Normally Open)

|||_J]_/ RESET A5 —

w—1 D0 (RX) Al fr—
— D1 (TX) A3
uI_ D2 A2
o
> — D3 (PWM) Al |
— D4 AD [
S
- vee GND f——] q
|||— GND AREF
XLAT1 AvCC L
16 MHz
Crystal XLAT2 D13 /)'
—— D5 (PWM) D12 :—Lui
=i D6 (PWM) D11 (PWM) o LED
Pr—
22pF 22pF —q D7 D10 (PWM) frmmm ~200 Q $
Capacitor |Capacitor Resistor 3
pu— pr— — D8 D9 (PWM) frmme

—I'_j_—‘r ATmega328

Figure 3.7: Arduino schematic diagram

Nano’s got the breadboard-ability of the Boarduino and the Mini+USB with smaller footprint
than either, so users have more breadboard space. It’s got a pin layout that works well with the
Mini or the Basic Stamp (TX, RX, ATN, GND on one top, power and ground on the other).
This new version 3.0 comes with ATMEGA328 which offer more programming and data

memory space. It is two layers. That make it easier to hack and more affordable.[10]

12



GND RXD
lRST l‘r)io

Microcontroller

(ATMEGA328P) Digits Fine

SMD Cystal
(16MHz)

POOOSHE
?2 ou 30308599 068,605?4 D3 Mmjf§T RXO rr?u v

Mini-B \ "' poers 1 X LED(WhIte)
U —ﬁ [ Y = Ml R X LED(Recl)
o L) . R K4 BT IE 87| — Power(Blue)

' : e = Pin13 LED
R:f[::aong::e - ‘512303 REF ~ “A17 A2 '83 A4 AS A6 [ﬁ_)-bb RSTGND VIN (Yellow)
Digital Pin 13 SEE E T XX R R N NN

3.3V Output

RESET Button
(150gf)

Analog Input Pins
RST Vin

Figure 3.8: Section of Arduino Nano.

SPECIFICATIONS:

e Microcontroller: Atmel ATmega328

e Operating Voltage (logic level):5 V

e Input Voltage (recommended):7-12 V

e Input Voltage (limits):6-20 V

e Digital I/0 Pins: 14 (of which 6 provide PWM output)
e Analog Input Pins: 8

e DC Current per 1/0 Pin: 40 mA

e Flash Memory: 32 KB (of which 2KB used by boot loader)
e SRAM :2KB

e EEPROM:1KB

e Clock Speed: 16 MHz

e Dimensions: 0.70” x 1.70”

FEATURES:

e Automatic reset during program download
e Power OK blue LED
e Green (TX), red (RX) and orange (L) LED

e Auto sensing/switching power input



e Small mini-B USB for programming and serial monitor
e ICSP header for direct program download
e Standard 0.1 spacing DIP (breadboard friendly)

e Manual reset switch

Micro-controller IC ATmega328p:

Figure 3.9: Microcontroller IC AT mega 328p.

The high-performance Microchip pico Power 8-bit AVR RISC-based microcontroller
combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 2KB
SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three flexible
timer/counters with compare modes, internal and external interrupts, serial programmable
USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-channel 10-bit A/D
converter (8-channels in TQFP and QFN/MLF packages), programmable watchdog timer with
internal oscillator, and five software selectable power saving modes. The device operates
between 1.8-5.5 volts. By executing powerful instructions in a single clock cycle, the device
achieves throughputs approaching 1 MIPS per MHz, balancing power consumption and

processing speed.

3.10 SWITCH MODE POWER SUPPLY (SMPS):

A switched-mode power supply (switching-mode power supply, switch-mode power
supply, switched power supply, SMPS, or switcher) is an electronic power supply that

incorporates a switching regulator to convert electrical power efficiently. Like other power
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supplies, an SMPS transfers power from a DC or AC source (often mains power) to DC loads,
such as a personal computer, while converting voltage and current characteristics. Unlike
a linear power supply, the pass transistor of a switching-mode supply continually switches
between low-dissipation, full-on and full-off states, and spends very little time in the high
dissipation transitions, which minimizes wasted energy. A hypothetical ideal switched-mode
power supply dissipates no power. VVoltage regulation is achieved by varying the ratio of on-
to-off time (also known as duty cycles). In contrast, a linear power supply regulates the output
voltage by continually dissipating power in the pass transistor. This higher power conversion
efficiency is an important advantage of a switched-mode power supply. Switched-mode power
supplies may also be substantially smaller and lighter than a linear supply due to the smaller

transformer size and weight.

Fig 3.10 : SMPS

Switching regulators are used as replacements for linear regulators when higher efficiency,
smaller size or lighter weight are required. They are, however, more complicated; their
switching currents can cause electrical noise problems if not carefully suppressed, and simple

designs may have a poor power factor.

12V 5A Industrial SMPS Power Supply — 60W — DC Metal Power Supply — Good Quality —

Non Waterproof with Aluminum casing.

e Input Voltage: AC 100 — 264V 50 / 60Hz
« Output Voltage: 12V DC, 0-5A
15
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« Output voltage: Adjustment Range: £20%

« Protections: Overload / Over Voltage / Short Circuit

e Auto-Recovery After Protection

« Universal AC input/ Full range

e 100% Full Load Burn-in Test

e Cooling by Free Air Convection

« High Quality and High Performance

o LED power supply with a metal body for hidden installation for LED lighting
« Design with Built-in EMI Filter, improve signal precision.
 Certifications: CE & RoHs

e No Minimum Load.

o Compact Size Light Weight.

« High Efficiency, Reliabiltiy & low energy consumption

o Category — Switch Mode Power Adaptor (SMPS)

Switched-mode power supplies are classified according to the type of input and output voltages.

The four major categories are:

. AC to DC
. DC to DC
. DCto AC
. AC to AC

A basic isolated AC to DC switched-mode power supply consists of:

. Input rectifier and filter

. Inverter consisting of switching devices such as MOSFETSs
. Transformer

. Output rectifier and filter

. Feedback and control circuit

The input DC supply from a rectifier or battery is fed to the inverter where it is turned on and
off at high frequencies of between 20 KHz and 200 KHz by the switching MOSFET or power
transistors. The high-frequency voltage pulses from the inverter are fed to the transformer
primary winding, and the secondary AC output is rectified and smoothed to produce the
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required DC voltages. A feedback circuit monitors the output voltage and instructs the control

circuit to adjust the duty cycle to maintain the output at the desired level.[11]

EMI
PFC

1254 Coil

O — '
Mains — i )
220V or

120V

BA4 x 2nos
in parailel

S5ohm

nte 4700
250~

Bridge rectifier is made using
4nos of 1N4007 diodes and the
capacitor is a 10uF/400V

Fig 3.11: SMPS Circuit Design

BASIC WORKING CONCEPT OF AN SMPS

A switching regulator does the regulation in the SMPS. A series switching element turns the
current supply to a smoothing capacitor on and off. The voltage on the capacitor controls the
time the series element is turned. The continuous switching of the capacitor maintains the

voltage at the required level.

DESIGN BASICS

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave bridge
rectifier. The rectified voltage is next applied to the power factor correction (PFC) pre-
regulator followed by the downstream DC-DC converter(s). Most computers and small

appliances use the International Electro technical Commission (IEC) style input connector. As
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for output connectors and pin outs, except for some industries, such as PC and compact PCl,

in general, they are not standardized and are left up o the manufacturer.

There are different circuit configurations known as topologies, each having unique
characteristics, advantages and modes of operation, which determines how the input power is
transferred to the output. Most of the commonly used topologies such as flyback, push-pull,
half bridge and full bridge, consist of a transformer to provide isolation, voltage scaling, and
multiple output voltages. The non-isolated configurations do not have a transformer and the

power conversion is provided by the inductive energy transfer.

ADVANTAGES OF SWITCHED-MODE POWER SUPPLIES:

o Higher efficiency of 68% to 90%

e Regulated and reliable outputs regardless of variations in input supply voltage
o  Small size and lighter

o  Flexible technology

e  High power density

DISADVANTAGES:

e  Generates electromagnetic interference
e  Complex circuit design

e  Expensive compared to linear supplies
Switched-mode power supplies are used to power a wide variety of equipment such as

computers, sensitive electronics, battery-operated devices and other equipment requiring high

efficiency.
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SWITCH MODE POWER SUPPLY
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Fig 3.12: Power Supply Connection

Linear voltage IC regulators have been the basis of power supply designs for many years as
they are very good at supplying a continuous fixed voltage output. Linear voltage regulators
are generally much more efficient and easier to use than equivalent voltage regulator circuits
made from discrete components such a zener diode and a resistor, or transistors and even op-
amps.The most popular linear and fixed output voltage regulator types are by far the positive
output voltage series, and the negative output voltage series. These two types of
complementary voltage regulators produce a precise and stable voltage output ranging from
about 5 volts up to about 24 volts for use in many electronic circuits. There is a wide range of
these three-terminal fixed voltage regulators available each with its own built-in voltage
regulation and current limiting circuits. This allows us to create a whole host of different power
supply rails and outputs, either single or dual supply, suitable for most electronic circuits and
applications. There are even variable voltage linear regulators available as well providing an
output voltage which is continually variable from just above zero to a few volts below its

maximum voltage output.

Most d.c. power supplies comprise of a large and heavy step-down mains transformer, diode
rectification, either full-wave or half-wave, a filter circuit to remove any ripple content from
the rectified d.c. producing a suitably smooth d.c. voltage, and some form of voltage regulator
or stabilizer circuit, either linear or switching to ensure the correct regulation of the power
supplies output voltage under varying load conditions. Then a typical d.c. power supply would

look something like this:
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Typical DC Power Supply

Unrequlated
——— Power Supply ———
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3.c. mains d.c. output
Transformer Rectifier Filter Regulator

Fig 3.13 : DC Power Supply Step

These typical power supply designs contain a large mains transformer (which also provides
isolation between the input and output) and a dissipative series regulator circuit. The regulator
circuit could consist of a single zener diode or a three-terminal linear series regulator to produce
the required output voltage. The advantage of a linear regulator is that the power supply circuit
only needs an input capacitor, output capacitor and some feedback resistors to set the output

voltage.

3.11 RELAY

A relay is an electrically operated switch. Many relays use an electromagnet to mechanically
operate a switch, but other operating principles are also used, such as solid-state relays. Relays
are used where it is necessary to control a circuit by a separate low-power signal, or where
several circuits must be controlled by one signal. The first relays were used in long
distance telegraph circuits as amplifiers: they repeated the signal coming in from one circuit
and re-transmitted it on another circuit. Relays were used extensively in telephone exchanges

and early computers to perform logical operations.
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Figure 3.14: Relay

A type of relay that can handle the high power required to directly control an electric motor or
other loads is called a contactor. Solid-state relays control power circuits with no moving parts,
instead using a semiconductor device to perform switching. Relays with calibrated operating
characteristics and sometimes multiple operating coils are used to protect electrical circuits
from overload or faults; in modern electric power systems these functions are performed by

digital instruments still called "protective relays”.[12]

Magnetic latching relays require one pulse of coil power to move their contacts in one direction,
and another, redirected pulse to move them back. Repeated pulses from the same input have no
effect. Magnetic latching relays are useful in applications where interrupted power should not

be able to transition the contacts.

Magnetic latching relays can have either single or dual coils. On a single coil device, the relay
will operate in one direction when power is applied with one polarity, and will reset when the
polarity is reversed. On a dual coil device, when polarized voltage is applied to the reset coil
the contacts will transition. AC controlled magnetic latch relays have single coils that employ

steering diodes to differentiate between operate and reset commands.
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Figure 3.15: Transistor Switching Circuit.

The circuit above is called a low-side switch, because the switch —our transistor — is on the low
(ground) side of the circuit. Alternatively, we can use a PNP transistor to create a high-
side switch: Similar to the NPN circuit, the base is our input, and the emitter is tied to a constant
voltage. A relay is an electrically operated switch of mains voltage. It means that it can be
turned on or off, letting the current go through or not. Controlling a relay with the Arduino is
as simple as controlling an output such as an LED. The relay module is the one in the figure

below.

Figure 3.16 : Relay Module.

This module has two channels (those blue cubes). There are other varieties with one, four and

eight channels.
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MAINS VOLTAGE CONNECTIONS:

In relation to mains voltage, relays have 3 possible connections:

Figure 3.17: Pin diagram of Relay Module

COM: common pin

NO (Normally Open): there is no contact between the common pin and the normally open pin.
So, when you trigger the relay, it connects to the COM pin and supply is provided to a load
NC (Normally Closed): there is contact between the common pin and the normally closed pin.
There is always connection between the COM and NC pins, even when the relay is turned off.

When you trigger the relay, the circuit is opened and there is no supply provided to a load.

If you want to control a lamp for example, it is better to use a normally-open circuit, because

we just want to light up the lamp occasionally.

Pin wiring:

The connections between the relay module and the Arduino are really simple:
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Figure 3.18: Main Voltage Connection
GND: goes to ground
IN1: controls the first relay (it will be connected to an Arduino digital pin)

IN2: controls the second relay (it should be connected to an Arduino digital pin if you are using

this second relay. Otherwise, you don’t need to connect it) VCC: goes to 5V

3.12 SERVO MOTOR

A servo motor is an electrical device which can push or rotate an object with great precision.
If you want to rotate and object at some specific angles or distance, then you use servo motor.
It is just made up of simple motor which run through servo mechanism. If motor is used is DC
powered then it is called DC servo motor, and if it is AC powered motor then it is called AC
servo motor. We can get a very high torque servo motor in a small and light weight packages.
Doe to these features they are being used in many applications like toy car, RC helicopters and

planes, Robotics, Machine etc.
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Figure 3.19 : Servo Motor

Servo motors are rated in kg/cm (kilogram per centimeter) most hobby servo motors are rated
at 3kg/cm or 6kg/cm or 12kg/cm. This kg/cm tells you how much weight your servo motor can
lift at a particular distance. For example: A 6kg/cm Servo motor should be able to lift 6kg if
the load is suspended 1cm away from the motors shaft, the greater the distance the lesser the
weight carrying capacity.

The position of a servo motor is decided by electrical pulse and its circuitry is placed beside
the motor.[13]

Servo Mechanism

It consists of three parts:

1. Controlled device
2. Output sensor

3. Feedback system

All motors have three wires coming out of them. Out of which two will be used for Supply
(positive and negative) and one will be used for the signal that is to be sent from the MCU.
Servo motor is controlled by PWM (Pulse with Modulation) which is provided by the control
wires. There is a minimum pulse, a maximum pulse and a repetition rate. Servo motor can turn
90 degree from either direction form its neutral position. The servo motor expects to see a pulse
every 20 milliseconds (ms) and the length of the pulse will determine how far the motor turns.

For example, a 1.5ms pulse will make the motor turn to the 90° position, such as if pulse is
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shorter than 1.5ms shaft moves to 0° and if it is longer than 1.5ms than it will turn the servo to
180°.

Servo motor works on PWM (Pulse width modulation) principle, means its angle of rotation
is controlled by the duration of applied pulse to its Control PIN. Basically servo motor is made
up of DC motor which is controlled by a variable resistor (potentiometer) and some gears.
High speed force of DC motor is converted into torque by Gears. We know that WORK=
FORCE X DISTANCE, in DC motor Force is less and distance (speed) is high and in Servo,
force is High and distance is less. Potentiometer is connected to the output shaft of the Servo,

to calculate the angle and stop the DC motor on required angle.

-

:1 ms guo

T

—

* Angular Rotation

Figure 3.20 : Schema Diagram of servo motor

Servo motor can be rotated from 0 to 180 degree, but it can go up to 210 degree, depending on
the manufacturing. This degree of rotation can be controlled by applying the Electrical
Pulse of proper width, to its Control pin. Servo checks the pulse in every 20 milliseconds. Pulse
of 1 ms (1 millisecond) width can rotate servo to O degree, 1.5ms can rotate to 90 degree

(neutral position) and 2 ms pulse can rotate it to 180 degree.

All servo motors work directly with your +5V supply rails but we have to be careful on the
amount of current the motor would consume, if you are planning to use more than two servo

motors a proper servo shield should be designed.
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3.13 BVM BOX

A bag valve mask (BVM), sometimes known by the proprietary name Ambu bag or generically
as a manual resuscitator or "self-inflating bag"”, is a hand-held device commonly used to
provide positive pressure ventilation to patients who are not breathing or not breathing
adequately. The device is a required part of resuscitation Kits for trained professionals in out-
of-hospital settings (such as ambulance crews) and is also frequently used in hospitals as part
of standard equipment found on a crash cart, in emergency rooms or other critical care settings.
Underscoring the frequency and prominence of BVM use in the United States, the American
Heart Association (AHA) Guidelines for Cardiopulmonary Resuscitation and Emergency
Cardiac Care recommend that "all healthcare providers should be familiar with the use of the
bag-mask device."[1] Manual resuscitators are also used within the hospital for temporary
ventilation of patients dependent on mechanical ventilators when the mechanical ventilator
needs to be examined for possible malfunction or when ventilator-dependent patients are
transported within the hospital. Two principal types of manual resuscitators exist; one version
is self-filling with air, although additional oxygen (O2) can be added but is not necessary for
the device to function. The other principal type of manual resuscitator (flow-inflation) is
heavily used in non-emergency applications in the operating room to ventilate patients during

anesthesia induction and recovery.[14]

Figure 3.21: BVM Box

METHOD OF OPERATION

Manual resuscitators cause the gas inside the inflatable bag portion to be force-fed to the patient
via a one-way valve when compressed by the rescuer; the gas is then ideally delivered through
a mask and into the patient's trachea, bronchus and into the lungs. In order to be effective, a
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bag valve mask must deliver between 500 and 600 milliliters of air to a normal male adult
patient's lungs, but if supplemental oxygen is provided 400 ml may still be adequate. Squeezing
the bag once every 5 to 6 seconds for an adult or once every 3 seconds for an infant or child

provides an adequate respiratory rate.

Professional rescuers are taught to ensure that the mask portion of the BVM is properly sealed
around the patient's face (that is, to ensure proper "mask seal™); otherwise, pressure needed to
force-inflate the lungs is released to the environment. This is difficult when a single rescuer
attempts to maintain a face mask seal with one hand while squeezing the bag with other.
Therefore, common protocol uses two rescuers: one rescuer to hold the mask to the patient's
face with both hands and focus entirely on maintaining a leak-proof mask seal, while the other

rescuer squeezes the bag and focuses on breath (or tidal volume) and timing.

An endotracheal tube (ET) can be inserted by an advanced practitioner and can substitute for
the mask portion of the manual resuscitator. This provides more secure air passage between
the resuscitator and the patient, since the ET tube is sealed with an inflatable cuff within the
trachea (or windpipe), so any regurgitation is less likely to enter the lungs, and so that forced
inflation pressure can only go into the lungs and not inadvertently go to the stomach (see
"complications”, below). The ET tube also maintains an open and secure airway at all times,
even during CPR compressions; as opposed to when a manual resuscitator is used with a mask

when a face mask seal can be difficult to maintain during compressions

3.14 LCD DISPLAY

LCD (Liquid Crystal Display) screen is an electronics display module and find a wide range of
applications. A 16x2 LCD display is very basic module and is very commonly used in various
devices and circuits. These modules are preferred over seven segments and other multi segment
LEDs. The reasons being LCDs are economical; easily programmable, have no limitation of
displaying special & even custom characters (unlike in seven segments), animations and so on.
A 16x2 LCD means it can display 16 characters per line and there are 2 such lines. In this LCD
each character is displayed in 5x7 pixel matrix. This LCD has two registers, namely, Command
and Data. The command register stores the command instructions given to the LCD. A
command is an instruction given to LCD to do a predefined task like initializing it, clearing its
screen, setting the cursor position, controlling display etc.

Features of LCD Display:
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Built-in controller (KS 0066 or Equivalent) + 5V power supply (Also available for + 3V) 1/16
duty cycle B/L to be driven by pin 1, pin 2 or pin 15, pin 16 or A.K (LED) N.V. optional for +
3V power supply.

Figure 3.22: 16*2 LCD Display

3.15 ARDUINO IDE

The digital micro controller unit named as Arduino Nano can be programmed with the Arduino
software IDE. There is no any requirement for installing other software rather than Arduino.
Firstly, Select "Arduino Nano from the Tools, Board menu (according to the micro controller
on our board). The IC used named as ATmega328 on the Arduino Nano comes pre burned with
a boot loader that allows us to upload new code to it without the use of an external hardware

programmer.

Communication is using the original STK500 protocol (reference, C header files). We can also
bypass the boot loader and programs the micro controller through the ICSP (In Circuit Serial
Programming) header. The ATmegal6U2 (or 8U2 in the revl and rev2 boards) firmware source
code is available. The ATmegal6U2/8U2 is loaded with a DFU boot loader, which can be
activated by:

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of Italy)
and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling the
8U2/16U2 HWB line to ground, making it easier to put into DFU mode.

The Arduino Nano is one of the latest digital microcontroller units and has a number of facilities
for communicating with a computer, another Arduino, or other microcontrollers. The
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ATmega328 provides UART TTL at (5V) with serial communication, which is available on
digital pins 0 -(RX) for receive the data and pin no.1l (TX) for transmit the data. An
ATmegal6U2 on the board channels this serial communication over USB and appears as a
virtual com port to software on the computer. The '16U2 firmware uses the standard USB COM
drivers, and no external driver is needed. However, on Windows, an .in file is required. The
Arduino software includes a serial monitor which allows simple textual data to be sent to and

from the Arduino board.

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial Communication on pins 0
and 1). A Software Serial library allows for serial communication on any of the Nano's digital
pins. The ATmega328 also supports 12C (TWI) and SPI communication. The Arduino software
includes a Wire library to simplify use of the 12C bus. Arduino programs are written in C or
C++ and the program code written for Arduino is called sketch. The Arduino IDE uses the
GNU tool chain and AVR Lab to compile programs, and for uploading the programs it uses
argued. As the Arduino platform uses Atmel microcontrollers, Atmel's development
environment, AVR Studio or the newer Atmel Studio, may also be used to develop software
for the Arduino.

The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a
text editor for writing code, a message area, a text console, a toolbar with buttons for common
functions and a series of menus. It connects to the Arduino and Genuino hardware to upload

programs and communicate with them.
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File Edit Sketch Tools Help

ZSP4TY_IOT_Finger_esp32_based_door_control
124 = REMOTEXY MODE ESPB2E6WIFL_LIB_CLOUD
14 #includs <ESPB26EWiFi.h>

1€ #include <RemoteXY.h>
18 #includs <Servo.h>

20 Serve myssrvo; // create servo object to control a servo

3| char strl[] = "Someone Detected";
char nor[] = "No Person";

steXY connection settings
£ = REMOTEXY_WIFI_SSID "abcds"
= REMOTEXY WIFI_PASSWORD "12345678"
f e REMOTEXY CLOUD SERVER "Cl‘jud.rem‘jtexy.cﬂm"
3 = REMOTEXY_CLOUD_PORT 6376
22 §define REMOTEXY CLOUD TOKEN "7152£825dceb29a9808£0552£c7529d2"

35 // RemoteXY configurate

Figure 3.23: Arduino Software Interface IDE

WRITING SKETCHES

Programs written using Arduino Software (IDE) are called sketches. These sketches are written
in the text editor and are saved with the file extension .ino. The editor has features for
cutting/pasting and for searching/replacing text. The message area gives feedback while saving
and exporting and also displays errors. The console displays text output by the Arduino
Software (IDE), including complete error messages and other information. The bottom
righthand corner of the window displays the configured board and serial port. The toolbar
buttons allow you to verify and upload programs, create, open, and save sketches, and open the

serial monitor.
UPLOADING

Before uploading your sketch, you need to select the correct items from the Tools > Board and
Tools > Port menus. The boards are described below. On the Mac, the serial port is probably
something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or
/devltty.usbserial-1B1 ~ (for a  Duemilanove or earlier USB board), or

/dev/tty. USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial
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adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COMS5,
COM?7, or higher (for a USB board) - to find out, you look for USB serial device in the ports
section of the Windows Device Manager. On Linux, it should be /dev/ttyACMXx , /dev/ttyUSBx
or similar. Once you've selected the correct serial port and board, press the upload button in the
toolbar or select the Upload item from the Sketch menu. Current Arduino boards will reset
automatically and begin the upload. With older boards (pre-Diecimila) that lack auto-reset,
you'll need to press the reset button on the board just before starting the upload. On most boards,
you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE)

will display a message when the upload is complete, or show an error.

When you upload a sketch, you're using the Arduino bootloader, a small program that has been
loaded on to the microcontroller on your board. It allows you to upload code without using any
additional hardware. The bootloader is active for a few seconds when the board resets; then it
starts whichever sketch was most recently uploaded to the microcontroller. The bootloader will
blink the on-board (pin 13) LED when it starts (i.e. when the board resets).

LIBRARIES

Libraries provide extra functionality for use in sketches, e.g. working with hardware or
manipulating data. To use a library in a sketch, select it from the Sketch > Import Library menu.
This will insert one or more #include statements at the top of the sketch and compile the library
with your sketch. Because libraries are uploaded to the board with your sketch, they increase
the amount of space it takes up. If a sketch no longer needs a library, simply delete its #include
statements from the top of your code.

There is a list of libraries in the reference. Some libraries are included with the Arduino
software. Others can be downloaded from a variety of sources or through the Library Manager.
Starting with version 1.0.5 of the IDE, you do can import a library from a zip file and use it in

an open sketch. See these instructions for installing a third-party library.
THIRD-PARTY HARDWARE

Support for third-party hardware can be added to the hardware directory of your sketchbook
directory. Platforms installed there may include board definitions (which appear in the board

menu), core libraries, bootloaders, and programmer definitions. To install, create the hardware
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directory, then unzip the third-party platform into its own sub-directory. (Don't use "arduino"
as the sub-directory name or you'll override the built-in Arduino platform.) To uninstall, simply

delete its directory.
SERIAL MONITOR

This displays serial sent from the Arduino or Genuino board over USB or serial connector. To
send data to the board, enter text and click on the "send" button or press enter. Choose the baud
rate from the drop-down menu that matches the rate passed to Serial.begin in your sketch. Note
that on Windows, Mac or Linux the board will reset (it will rerun your sketch) when you
connect with the serial monitor. Please note that the Serial Monitor does not process control
characters; if your sketch needs a complete management of the serial communication with
control characters, you can use an external terminal program and connect it to the COM port
assigned to your Arduino board. You can also talk to the board from Processing, Flash,

MaxMSP, etc (see the interfacing page for details).

3.16 PROTEUS SOFTWARE

The Proteus Design Suite is a proprietary software tool suite used primarily for electronic
design automation. The software is used mainly by electronics design engineers and technicians

to create schematics and electronics prints for manufacturing printed circuit boards.

The first version of what is now the Proteus Design Suite was called PC-B and was written by
the company chairman, John Jameson, for DOS in 1988. Schematic Capture support followed
in 1990 with a port to the Windows environment shortly thereafter. Mixed mode SPICE
Simulation was first integrated into Proteus in 1996 and microcontroller simulation then arrived
in Proteus in 1998. Shape based auto routing was added in 2002 and 2006 saw another major
product update with 3D Board Visualization. More recently, a dedicated IDE for simulation
was added in 2011 and MCAD import/export was included in 2015. Support for high speed
design was added in 2017. Feature led product releases are typically biannual, while

maintenance-based service packs are released as required.
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Figure 3.24: Our Project Design in Proteus Software
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CHAPTER 4
RESULT & DISCUSSION

4.1 RESULT

a) We have been study about ventilation system and its mechanism how its work.

b) We have been able to design and construct a simple and inexpensive ventilation system.

c¢) Our ventilation system works very well as expected. Its variable Breathing speed function is

working very well.

d) We have been able to build our system by following all the objects and methodologies. At first
we have set up the all components well for our system. Here the BVM bag will be filled by the
oxygen and servo motor will be compress the bag to supply the gas in patient breath. The
efficiency of this project is very good. It is capable of working for a long time. We are satisfied

its performance.

4.2 DISCUSSION
This kind of project already many of student study before, but they control it PLC system. We

control with servo motor and micro-controller mechanism. When we made this project then we

face some of problem. We did not run it smoothly. After hard work and team work we did it .

4.3 ADVANTAGE

e Easyof Use

e Cost Effective

e Maintenance is easy and cheap.

e Very effectively work for covid-19 patient

e The project is compact, cheap and user friendly.

e The whole system consumes very little energy.
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e Less skill technicians are sufficient to operate.

e Simple construction

4.4 APPLICATION

This project has applications in many fields due its necessity. We have selected a few of them

and they are given below:
e Hospital

e Pharmacy

45 LIMITATION

It is a demo project so we found some limitation. In future we will work for reduce this kind
of limitation. These limitations are —
e Itis ademo project so its accuracy is 85%.

e Our project may delay in work.
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CHAPTER S
CONCLUSION

5.1 CONCLUSION

In this technical note, a highly innovative ventilator design is proposed. The concept is still
under development. Future iterations will include changes induced by the results of our
prototype testing. It will incorporate an adjustable inspiratory/expiratory ratio that will be
displayed on a LCD screen. Many cost-affective and precise sensors that interact with the
human body and ensure that air is administered deliberately and accurately will also be added.
Our goal is to provide a new and inexpensive solution. Finally, we will test the ventilator on
various patients’ respiratory tracts to compare its performance with conventional ventilators

before launching the product onto the market.

5.2 FUTURE SCOPE

The model can be improved by making some changes in the program and components. Some

suggestions are given below-

» We can add a monitoring based control to automate control.
« We will increase its working accuracy level.
+  We will add IoT Management System.

» We will add more sensor to detect patient various condition at a time.
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Appendix

Micro-controller Code :

#include <Wire.h>
#include <LiquidCrystal_12C.h>

LiquidCrystal _12C lcd(0x27,16,2);

#include <Servo.h>

Servo myservo; // create servo object to control a servo

Servo myservol; // create servo object to control a servo

int pos = 0; // variable to store the servo position
int posl =0; // variable to store the servo position

int pot = AQ;

int switchl= 2;

int switch2= 3;

void setup() {
Serial.begin(9600);
Icd.init();
Icd.backlight();
Icd.begin(16,2);

Icd.clear();

myservo.attach(5); // attaches the servo on pin 9 to the servo object
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myservol.attach(6); // attaches the servo on pin 9 to the servo object
pinMode(2,INPUT);
pinMode(3,INPUT);

pinMode(A0,INPUT);

void loop() {
int switch1l = digitalRead (2);
int switch22 = digitalRead (3);

int pott = analogRead (A0);

int pottt = pott/50;

Serial.printin(pottt);

/' Icd.setCursor(0, 0);
cd.print("Value");

if(switchll == HIGH){
Icd.setCursor(0, 0);
lcd.print("Natural On ™);
lcd.print("V:");
Icd.print(pottt);

led.print(" ");

for (pos = 0; pos <= 50; pos += 1) { // goes from 0 degrees to 180 degrees

I in steps of 1 degree



myservo.write(pos); I/ tell servo to go to position in variable 'pos'

myservol.write(pos); // tell servo to go to position in variable 'pos’
delay(pottt); [/l waits 15 ms for the servo to reach the position
¥
for (pos = 50; pos >= 0; pos -= 1) { // goes from 180 degrees to 0 degrees
myservo.write(pos); // tell servo to go to position in variable 'pos'
myservol.write(pos); // tell servo to go to position in variable 'pos'
delay(pottt); // waits 15 ms for the servo to reach the position
}
¥

if(switch1l == LOW){
Icd.setCursor(0, 0);
Icd.print("Natural Off ")
myservo.write(50); // tell servo to go to position in variable 'pos'
myservol.write(50);
¥
if(switch22 == HIGH){
Icd.setCursor(0, 1);

Icd.print("Cylinder On ");

}
if(switch22 == LOW){
Icd.setCursor(0, 1);

Icd.print("Cylinder Off ™);
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}

¥

delay(100);
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